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B ‘Ig W fo.v- S mProM as we turn 10, but it’s business as usual, even as the

year draws to a close. It’s no change for the newsletter either — as another massive newsletter comes to you (who would have thought
you could have so much in a monthly newsletter on Excel and financial modelling!?).

This month, we turn our attention to Microsoft’s recent Ignite conference and reveal what the future holds for Excel given the
announcements that were made. Some big news follows!

We have all of the regulars too: VBA Basics, Power Pivot Principles, 20 gazillion Power Bl updates (including a new-look Ribbon), we take
our look at the A-Z of Excel Functions to the DMAX, and even have time to mention training and keyboard shortcuts to you.

Season’s greetings to you all — time to enjoy the end of year celebrations.

See you next year.

L-(‘,a/W\z Ba&ﬁ,ok, Managing Director, SumProduct ' L
|

Now We Are 10!

Neither the website nor the company went “live” until January 2010, but SumProduct sprang to life in December 2009 as founder Liam Bastick started
putting the material together before Christmas for what has turned out to be an exciting 10 years. This seems like a good time to lay a stake in the

ground for our “birthday”.
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Financial models are a key component in all major business decisions.

Just one modelling error has the potential to destroy significant business
value and lead to incorrect actions being undertaken.

Therefore, it is important that key decisions are based on a model that is:
s Consistent
» Transparent
¢ Flexible
* Robust
[ Learn more about these four kev concepts ]

SumProduct can cater for all of your modelling needs, using some of the
most experienced modellers available at highly competitive rates.

Contact us to find out more.

Copyright © 2009-2010 SumProduct Pty Ltd. All rights reserved.

They say if a company survives five years it will keep going until the owners decide to sell it or shut it. Well, it’s lasted 10 years now and continues to
thrive! The first Thought article didn’t appear until April 2010, but look how far we have come since...

MVP

Microsoft-
Most Valuable
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SumProduct: Your Financial Modelling Experts

Modelling is a key component in all major business decisions. Be it financial modelling, investment appraisal, decision support or what-if analysis, you need business models you
can rely upon. Just one modelling error has the potential to destroy significant business value and lead to incorrect actions being undertaken.
Therefore, itis important that key decisions are based on a model that is: Consistent, Robust, Flexible and Transparent - this is known as “CRaFT”. Read More

We are going to celebrate at the end of this month — and toast to another
10 years as we continue to grow. Thanks for being there with us.

There are no plans for a sale or a shutdown here: we are going to continue
offering our clients all things analytical, with offerings in modelling,

This Excel is on Fire

Well, it’s Ignite-d anyway! One of Microsoft’s flagship events, Ignite,
occurred last month in Florida. Targeting over 25,000 individuals focused
on software development, security, architecture and information
technology, the event showcases new hands-on experiences that help
users innovate in areas such as security, cloud, hybrid infrastructure and
development.

Butit’s not all Sheldon Cooper and relativistic quantum mechanics. There
was plenty on offer to interest the “mere” accountants in the room too.
You’d think with the big data, visualisation and collaboration revolutions
reinventing themselves on almost a daily basis, there would be no place

Natural Language Ideas Provides Insights

strategy, planning and training. There’s been two books released so far,
with at least two more in the pipeline — but more about that next year.

Keep reading. Keep interacting. We're going to keep going.

for technology that’s been around for over 30 years.
But you’d be wrong.

Excel is still the irritating little upstart that refuses to go away. | often
joke that Excel is the second-best software in the world. What for? The
thing you can’t afford otherwise. It seems as true now as ever it did, and
Ignite ensured it would remain as important a piece as ever in what is the
Microsoft jigsaw.

It was central to several key announcements. Allow me to take you
through them.

Ideas was previously announced at last year’s Ignite conference. According to fellow Excel Most Valuable Professional (MVP) Bill Jelen, Ideas was the
“... first icon added to the ‘Home’ tab in 11 years, 8 months, 23 days. It must really be something special”.

Insert Page Layout Formulas Data

Essentially, this feature was Excel’s answer Power Bl’s highly popular
‘Quick Insights’. Often, understanding data can be quite a challenge,
especially if the volume of data is large or if it's an unfamiliar dataset.
With Ideas (previously known as Insights), Excel automatically points

Review View

Q Tell me what you want to do

4

<1 A= General &Condmonal Formatting ~ E‘” Insert ~ Z %
$-%°* Dfon‘nat as Table - E" Delete ~ E v |deas
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'8 (7 Cell Styles = &) Format~ & ~
Clipboard 1% Font ] Alignment Number Styles Cells Editing Ideas A

out interesting patterns in user data, like trends and outliers. Ideas in
Excel shows high-level summaries, statistically significant findings and
recommended visualisations. It also helps you leverage Excel PivotTables
and PivotCharts.

Previous updates have included easier to understand chart previews, new types of analysis (e.g. scatter and outlier charts), and updated machine
learning models to make more powerful suggestions. That’s right: all that insight from just pressing a button:
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For 'Single' Customers,there are 5 outliers by '‘Geography'.
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It’s really easy to use. For best results, have just one data table on an Excel worksheet (preferably using an Excel Table, CTRL + T), click anywhere on
the worksheet and then simply press the Ideas button on the Home tab:
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With an internet connection, the Ideas pane will appear shortly thereafter with some thoughts about your data, which you can choose to review,
accept, investigate or ignore. |deas are displayed graphically in the pane, ready for you to reproduce in Excel simply by clicking on them:
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It will highlight the most salient points and guide you towards other findings (note the comment, ‘Show all 35 results’, at the bottom of the Ideas pane
above). You can even guide Ideas regarding which fields are of most interest. It learns.
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This is old hat though, quite frankly. It’s now gone a step further. natural language query will quickly answer users’ data questions with
formulae, PivotTables or PivotCharts. The feature will be available on
Windows, Mac and Excel for the web in English language only at this
time, with plans to expand to other languages soon.

Rolling out to Office Insiders from early November (it is being made
available to customers on a gradual basis, starting with Office 365
subscribers on the Monthly Channel in English), natural language query
is a feature in Ideas in Excel that allows users to ask a question of their  All you have to do is ask a question in English (“a natural language
data to glean insights without having to write complicated formulae. query”):

Using the Artificial Intelligence algorithms that powers Ideas in Excel,

Ideas v X

b Ask a gquestion about your data
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=+ Insert PivotChart s this helpful?

Just clicking inside the question box provides suggestions:
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=+ Insert PivotChart s this helpful?

Whether you ask your own question or plump for one of the suggestions,  This type of functionality has gone down a storm in Power Bl. There’s no
Ideas will provide answers supported by formulae, PivotTables or reason why this powerful feature won’t cause a similar stir for Excel users
PivotCharts that may be inserted into the workbook. in the near future too.

XLOOKUP (and XMATCH) Progress Report

As several readers pointed out, we “lied” to you in a previous newsletter item. Late October saw the previously announced XLOOKUP function
modified, with the addition of if_not_found, but Microsoft changed its mind about its positioning. It’s moved from being the sixth (final) argument
to the fourth argument:

XLOOKUP(lookup_value, lookup_vector, results_array, [if_not_found], [match_mode], [search_mode])

This was highlighted at Ignite as it’s the first time syntax order has been changed. This clearly shows Microsoft is listening to its users and is prepared
to adapt. That can only be good news for us all. Presumably, the thinking was this argument will be important to many users and hence has been
prioritised accordingly.

We eagerly look forward to it moving into first place next month and winning the race.
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Having this error case as an argument is consistent with other existing
functions such as IFERROR and IFNA, as well as the dynamic array function
FILTER. It seems like a good idea as having this argument present as it
can tell you when something in your spreadsheet is not working as you
might think.

It was further emphasised that this additional argument won’t be coming
to XMATCH, a turbo-charged version of MATCH.

| have mentioned these two functions several times recently, so | am
conscious | don’t wish to over-emphasise these two new functions, but
the revisions to XLOOKUP are beneficial. Consider the following example:

G25 -~ % | =XLOOKUP($GS$21,51$12:51516,5HS12:5H516,"Not Found",GS24,5F25)
c|Db|E F G H | J K L [ N o P Lo}
S
<10 Data
Son
- 12 A 7
13 B
14 &
15 D
16 E
17
18
- 19 Solution
.20
-2 SearchValue[ 65 |
-2
23
24
- 25 Not Found Not Found =XLOOKUP(SGS21,5IS12:SI516,SHS12:SHS16, "Not Found", GS24,5725)
. 26 E NotFound A NotFound
-7 NotFound NotFound | #VALUE!
. 28 E NotFound A #VALUEL
29

Notice that | am searching the ‘Value’ column, which is neither sorted nor contains unique items. Do you see how the results have changed once

more, depending upon match_mode and search_mode?

Match Mode

-1 1 2
e Not Found B A Not Found
2 Not Found D A Not Found
E Not Found E Not Found #VALUE!
@ Not Found B A #VALUE!

The match_mode zero (0) returns “Not Found” now instead of #N/A
because there is no exact match and the formula has now stipulated
what to do in such an instance.

When match_mode is -1, XLOOKUP seeks an exact match or else the
largest value less than or equal to lookup_value (6.5). That would be
4 — but this occurs more than once (B and D both have a value of 4).
XLOOKUP chooses depending upon whether it is searching top down
(search_mode 1, where B will be identified first) or bottom up (search_
mode -1, where D will be identified first). Note that with binary searches
(with a search_mode of 2 or -2), the data needs to be sorted. Itisn't —
hence we have garbage answers that cannot be relied upon.

With match_mode 1, the result is clearer cut. Only one value is the
smallest value greater than or equal to 6.5. That is 7, and is related to
A. Again, binary search results should be ignored, although it is worth
noting “Not Found” occurs when Excel identifies the lookup value has
not been found.

Non-Disrupting Collaboration

Accessibility and collaboration are two of Microsoft’s current priorities.
Allowing all users to be able to use Excel is a good thing, but for me, the
jury remains out on the importance of more than one user working on
an Excel file at the same time. Most of the time this causes problems
for accountants, with version control and data ownership being just two
key issues.

This hasn’t deterred Microsoft. Their telemetry does suggest they
are right, and my misgivings are misguided. One concern they have

The match_mode 2 results are spurious. This is seeking wildcard
matches, but there are no matches, hence “Not Found” instead of N/A
for the only search_modes that may be seen as creditable (1 and -1). It’s
interesting to note a binary search causes errors which are not trapped
by the new argument.

Clearly binary searches are higher maintenance. In the past, it was worth
investing in them as they did return results more quickly. However,
according to Microsoft, this is no longer the case: apparently, there is “...
no significant benefit to using (sic) the binary search options...”. If this is
indeed the case, then | would strongly recommend not using them going
forward with XLOOKUP.

It was announced that XLOOKUP and XMATCH will become Generally
Available “in the coming months”. What that means exactly is yet to be
determined.

identified is when users open a shared workbook and become concerned
when they see data is apparently missing or has been reordered, only
to realise another user has made such a change in real time. That may
happen regularly for good reasons. Wouldn’t it be good if you could
choose to make changes to a worksheet without disrupting others, i.e.
decide whether a change should be viewed just by you or by everyone?

4.23 474.89
2.05 i
138 ] Do this just for you?

You just sorted or filtered, but that could interrupt others

Do this just for me

Do this for everyone
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Ignite has announced ‘Sheet View’ on Excel for the web, making this a
problem of the past. ‘Sheet View’ allows users to sort and filter data,
and then select whether to share these changes with others. Once the
decision has been made, you can also save the results to view again as a
separate view, if desired. All this can be done without disrupting others’
view of the data on a shared file.

F v  Computer

Sheet View will be available by the end of December on Excel for the web.

Document Classification and Access Protection

Microsoft has undertaken a lot of work in the recent past around
collaboration (as | have just mentioned!). Sharing files and co-authoring
has indeed become easier, but this has led to security considerations.
Staff in an organisation need to collaborate both internally and
externally. This means that content no longer stays behind a firewall — it
roams everywhere, across devices, apps, and services. When it roams,
companies need to ensure it is managed in a secure, protected way that
meets both business and compliance policies.

AutoSave m E

It goes further though. Views may also be saved so that they may be
accessed by other users in the document when collaborating in real time,
avoiding disruptions in workflows across teams. All they need to do is
click on the View tab and find the ‘Sheet View’ they need in the drop-
down list on the Ribbon:

Vo .

Understanding both your data and its inherent level of sensitivity,
together with incorporating appropriate protection, will help preserve
your organisation’s most sensitive information. Already in production
on Mac and Excel Mobile, Ignite has announced that manual sensitivity
labelling is now to roll out on Excel on Windows and the web for Office
365 subscribers.

File Home Insert Draw Page Layout Formulas Data Review View Help 7 C G
A i = % E"Ccnd\lm:u: Formatting ~ EEi p g
- Font | Alignment | Number FiZi Format as Table « Cells | Editing | ideas
~ v - " 5% Cell Styles ~ s z
S L Stybes e someonewhocares@sumproduct.com
3 Customer Invoice Sales ($ '000)
4 Customerl  Inv:1000 37 General
5 Customer2 Inv:1001 7 Internal
6 Customerd  Inv:1002 6
7 Customerd  Inv:1003 167 Conficleriiol = Fnarics
Customer5  Inv:1004 43 Confidential - Top Secret
9 Customeré  Inv:1005 8
10 Customer? Inv:1006 18
1 Customer8  Inv:1007 S
12 Customer9  Inv:1008 187
13 Customerl0 Inv:1009 28
14 Customerll Imv:1010 72
15 Customerl2 Inv:1011 27
16 Customerl3 Inv:1012 31
17 Customerld Inv:1013 7
18 Customerl5 Inv:1014 2
19 Customerl6 Inv:1015 18
20 Customerl? Inv:1016 6
21 Customerl8 Inv:1017 4
+ “ »
essibility. Good 10 go g Display Settings ] 2] m 1 1

A shared workbook can be accessed if a user has access rights provided
by any encryption associated with the sensitivity label (labels can be
configured to have encryption). For example, if a workbook is labelled

Internal, it restricts read / write access to employees of a company, which
means employees will be able to open, view and modify content in the
document while access is restricted to external users.
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» Creates a sensitivity label

* Publishes the sensitivity label to users and groups
selected in a label policy

» Works on an email or document and sees the available labels
» Classifies the document by applying a label

» Enforces protection settings on the email or document based

Office or on the applied label

third-party
app/service

Even though the process is manual, recommended labels may be through the Home -> Sensitivity button (shown above).
suggested automatically. Excel will notify you of potential sensitive
content in the workbook and recommend a label per your administrator’s
security settings. Labels will be visible in the Status Bar, and adjustable

This automatic sensitivity labelling will also be rolling out to Insider Fast
for Excel on Windows and in Preview for Office on the web.

The Write Move for Office Scripts?

Two and a half years ago, Microsoft released Script Lab, a little-known add-in for Excel (and other applications) described at the time as a "Microsoft
Garage" project (isn't that a type of '80's music?).

Book1 - Excel Michael Saunders ~ [E

Home Insert Draw Page Layout Formulas Data Review View Script Lab Q Tell me

=1 (=) —
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Code Run  Tutorial Help  Reference Askthe
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Script About Script Lab About the APIs ~
Ad w7 I »
A B € D E -
1 Code v u
2 — - =
3 = BasicAPlcall &2
< .
s Script  Template Style
6 Excel.run(
7
8
9
10 range
11
12
13
14
15
16
17
18 - -
- @ About @ &) Dark 0
Sheetl (O] [ 3 =
Ready &3 ice 0 - 1 +  100%

Script Lab was a tool for anyone who wanted to learn about writing add-ins for Excel, Word or PowerPoint. Microsoft were — and still are — keen to
push the JavaScript application program interface (API), as they see it as the technology needed for building Office add-ins that run across platforms.
Script Lab had three main features:

1. Code in a pane beside your spreadsheet

2. Run the code in another pane beside the editor

3. Share your snippets elsewhere.
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The problem was, it was really aimed at expert users and quite frankly,
didn’t really take off.

Well, if at first you don’t succeed, try, try again. Maybe not a great motto
for parachute enthusiasts, but nevertheless one Microsoft has embraced.
This month’s Ignite has seen “Take 2” announced. Office Scripts has just

been announced as a new feature that enables users, whether novice or
expert, to record scripts and automate their tasks.

It’s similar in some ways to the old VBA macro recorder. Users begin by
clicking the Record button in the new Automate tab, recording the actions
desired, stopping the recorder, and then saving / editing the script.

Excel inventorySales -

Home  Insert ita  Review

Model Sryle Notes Cont Quantity

These scripts willbe saved to OneDrive for Business for greater accessibility
and collaboration. They may then be run manually, automatically (using
Flow, say), or conditionally based upon a trigger.

For the more experienced, Office Scripts also allows you to take these

Dynamic Arrays Becoming Generally Available

Never mind any of the above. If the responses to my Linkedln account
are anything to go by, half the world has been waiting for this. The long-
awaited roll-out of dynamic arrays starts now. Microsoft has announced
at Ignite they will slowly become Generally Available starting in early
November with Excel for the web.

You are going to need Office 365 at some point (it's not coming to either
Excel 2016 or Excel 2019), but Microsoft has stated that they "...will be

L13 N ﬁ

" b Script Recorder
Sales
» L]

$07,6 ®) Recording wop [ Absonte

Recorded Actions

recorded scripts and extend them using the same Excel JavaScript APIs
that are available in Office Add-ins.

The feature will be available in Preview on Excel on the web by the end
of 2019 (I have no information about availability on Office 365 Insiders).

rolling out to subsets of our users to continue to gather feedback and
monitor quality...".

| have written about these at length, but in case you have just returned
from Uranus, imagine a world of sorting data, identifying list items and
filtering out what you don’t want formulaically with formulae that take
three or four seconds to write...

=SORT(UNIQUE(F13:F41))

cC D E F G H | J K L M M 0
9
10 Original Data Results
11
12 Store  Salesperson Section Manager 0 alesperso ectio anage
13 Morth Alice White Goods  |Zack East Alice White Goods |Zack
14 MNarth Barbara Groceries Zack MNarth Barbara Groceries Yvonne
15 Morth Charlie White Goods |Zack South Charlie Computers  Xander
16 Marth Dion Computers Yvonne West Dion Insurance Winnie
17 Morth Echo Insurance Hander Echo Bedding
18 Morth Fred Bedding Winnie Fred Audio Video
19 Marth George Audio Video  |Ywonne George Furniture
20 Marth Helen Furniture Winnie Helen
21 MNarth Irig White Goods |Zack Iris
22 MNarth Jack Furniture Winnie Jack
23 Marth Karla Groceries Zack Karla
24 East Lindsay Insurance Hander Lindsay
25 East Barbara Groceries Zack Michael
26 East Iris White Goods  |Zack Mancy
27 East Michael Computers Yvonne Qprah
28 East Fred Bedding Winnie Pete
20 Fast Minn Mnmnntars Yunnna
Ah, bliss...
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“Bulgaria and Slovenia Excel Conferences Completed!

It’s been two conferences in two weeks for SumProduct’s very own Liam Bastick and several other Excel MVPs as they quickly followed up Sofia’s
Bulgaria Excel Days 2019...

EXCEL IN BUSINESS, DATA A*'ALYSIS AND VISUALISATION,
POWER BI SOLUTIONS, FINANC . )DELLING, v:;‘-aes'r PRATICES

CAC
s cler Prooce

Seems like Excel MVP Gasper Kamensek had time for a haircut between the two events...

With over 300 attendees between the two events, the Excel Summits can be viewed as a great success. Of course, there will be more similar events
next year. Liam’s not done yet though: he still has events in London, Melbourne and Brisbane to complete before Christmas, lucky boy!!

Stay tuned to these newsletters to be one of the first to find out and take advantage of any and all discounts going!
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A useful tip to consider when working in VBA is to ensure that your code doesn’t rely on specific cell references such as B10 or C4, at least, if you don’t

want your macros to do things unintentionally.
Let’s look at a typical block of recorded code:

Sub Macrol()

Range ("C3") .Select

Selection.Copy

Range ("D4") .Select
ActiveSheet.Paste

Range ("C4"™) .Select
Application.CutCopyMode = False

Selection.Copy

Range ("E6") .Select
ActiveSheet.Paste

End Sub

Now, this code works well if no changes are made to the structure of the
spreadsheet. However, if rows or columns are inserted, this will cause
errors, since the macro will point to cell C3 in the first line, irrespective of
where the original cell was. To avoid this, instead of using cell references,
we can define cells with Range Names.

Sub Macrol ()
T

' Macrol Macro

By defining code using range names, you ensure that the code will only
impact exactly the cells you want it to, unless the range name is deleted.
This gives you much code that will keep working even if columns and
rows are added or deleted, as long as the relevant range names still exist.

Range ("Start") .Select

Selection.Copy

Range ("End") .Select
ActiveSheet.Paste
Range ("01d") .Select

Application.CutCopyMode

Selection.Copy

False

Range ("New") .Select
ActiveSheet.Paste

End Sub

Hopefully, this makes sense! Next time we will start cleaning up the code and making it appear more professional.

More next month.

Power Pivot Principles

We continue our series on the Excel COM add-in, Power Pivot. This month, we look at being able to tell the difference between fields and measures.

Below you will find a screenshot of the fields list from a PivotTable in Excel.

[ ProductKey

Can you tell which items are measures and which items are fields?

[ ProductStandardCost
[] PromotionKey

[] salesAmount

[] salesOrderLineNumber
[] salesOrderMumber
[] salesTerritoryKey

[ Taxamt

[] TotalProductCost

[ unitPrice
[ fi Profit
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Measures are displayed with the “f” symbol, so in the list above the
‘Profit’ item is a measure and the rest of the items are simply fields. If
the list is unsorted, these measures will appear at the bottom of the list.

This screenshot above is from Excel 2016. In earlier versions, the measure
is often denoted with an ‘M’ instead, which is actually a little confusing
for Excel 2013 users as Power Pivot uses the erroneous nomenclature of

Power Query Pointers

“calculated field” to describe a measure in this version of the software.
(A calculated field is a field in a table which contains a formula; a measure
is a calculation which is applied to the filtered aggregation of one or more
fields and / or calculations).

More Power Pivot Principles next month.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from
www.sumproduct.com/blog. If you wish to read more in the meantime, simply check out our Blog section each Wednesday. This month, we take a

look at combining columns when some values are null.

Previously, we have shown how easy it is to pivot columns. For example,
if we pivot the expense code column to show the amounts for each
expense code, we might have a table with lots of null values in it, as

shown below. Let’s use this table to show how we may sum columns
where some values are null.

Pivot Column - Query Editor X
“ Home  Transform  AddColumn  View -]
A5 [ By Properes ) WY WX 4 ) o Dawpetecr [ Merge Queries ~ [L [ New Source ~
) = = N
= & [ Advanced Editor X HH HH H ILLE [77] Use First Row As Headers ~ % Append Queries ~ Lo [ Recent Sources ~
Closes Refresh Choose Remove  Keep Remove split  Group . Manage  Data source
Load~  Preview~ ti Manage Columns Columns~  Rows~ Rows~ Column~ By 2 Replace Values Combine Files Parameters~  settings
Close Query Manage Columns Reduce Rows  Sort Transform Combine Parameters  Data Sources New Query
fc || = Table.Reordercolumns (#"Pivoted Column",{"Department”, “Expense Category”, "Expense Type", "LEN(Expense || Query Settings x
. nal [~ ][ Date ~| % Employee  [~] 12 Petrol ~]12 Hotel  [~|12 Food  [~]12 Sundries  [~|12 Stationary  [v|12 Train  [~|1.
B 11/05/2015 00:00:00 Mary Wells null null 39 null null null 4 PROPERTIES
S 2 11/05/2015 00:00:00 Mary Wells null 210 null null null null Name
3 11/05/2015 00:00:00 Mary Wells 40 null null null null null Pivet Column
4 12/05/2015 00:00:00 Mary Wells null null 12.45 null null null All Properties
5 12/05/2015 00:00:00 Mary Wells null null null 11.12 null null
4 APPLIED STEPS
6 13/05/2015 00:00:00 Derek Stand null null 43.16 null null null
7 13/05/2015 00:00:00 | Derek Stand null 130 null null null null Source
8 13/05/2015 00:00:00| Derek Stand 50 null null null null null Changed Type
9 13/05/2015 00:00:00 Paul Simmons null null 43.16 null null null Pivoted Column
X Reordered Columns.
10 13/05/2015 00:00:00 Paul Simmons null 130 null null null null
11 13/05/2015 00:00:00 Paul Simmons null null null null null null
12 13/05/2015 00:00:00 Paul Simmons null null null null null 45
13 14/05/2015 00:00:00 | Derek Stand null null 22.95 null null null
14 14/05/2015 00:00:00| Paul Simmons null null 2295 null null null
15 20/05/2015 00:00:00 Mary Wells null null null null 5 null
< >

15 COLUMNS, 15 ROWS PREVIEW DOWNLOADED AT 12:47

We are going to create a column which adds up everything in the Petrol, Hotel, Food, Sundries, Train and Taxi columns. One thing not to do, is to try
and add them all up in a custom column, so we’ll start there and show you what happens if you do!

In the ‘Add Column’ tab, choose the ‘Custom Column’ option:

< | Pivot Column - Query Editor

Home  Transform  Add Column  View [~}
Ei Conditional Column ', Merge Columns Trigonometry = D
| A3C| /
Index Column = 55 Cxtract = ) Rounding =
Custom Invoke Custorm L Format .. . Stetistics Stardard Scientific ; . Dale  Time Duralivn
Column  Function [ Duplicate Column L B Darce S . . Informatic S . .
General From Text From Numiber From Dale & Time:
jx - Table.ReorderColumns(#"Pivoted Cclumn”,{"Department”, "Expense Category"”, "Expense Type", "LEN(Expense o) C atti v
> Jx ¢ {"D=p P gory’ P VP (Exp vl Query Settings v
E3. nat [~ |[07] Date v | A% Employee |~ |12 petrol *|12 Hotel ~|1.2 Food ~ |12 sundries ~ 12 stationary v |12 Train v]1:
@ 1 11/05/2015 00:00:00 Mary Wells null nul! 33 null aull null 4 PROPERTIES
g 2 11/05/2015 00:00:00 | Mary Wells null 210 null null aull null Name
3 11/05/2015 VU:00:00 | Mary Wells m null null null aull rull Piver Column
4 12/05/2015 00:00:00 | WMary Wells null null 17.45 null ull rull All Properties
5 12/05/2015 00:00:00 Wary Wells null nul! null 11.12 aull null
4 APPLIED STEPS
6 13/05/2015 00:00:00  Derek Stand null null 43.16. null aull null
s
7 13/U5/2015 VU:00:00 | Derek Stand null 130 nutl null Aull null source
s 13/05/7015 00:00:00 | Darek Stand 50 nutl nutl null ll rull Changed Type
Fivoted Column
9 13/05/2015 00:00:00 Paul Simmons null nul! 43.10 null aull null
X Reordered Columns
10 13/05/2015 00:00:0 | Paul Simmons null 130 null null aull null
n 13/05/2015 VU:00:00 | Paul Simmons null null null null null null
12 13/05/7015 00:00:00 | Paul Simmons null nuill’ null null null 45
13 14/05/2015 00:00:00 Derek Stand null nul! 22.95 null aull null
14 14/05/2015 00:00:0 | Paul Simmons null null 22,95 null aull null
15 20/U5/2015 00:00:00 | Miary Wells null null null null 5 null

15 COLUMNS, 15 ROWS

PREVIEW DOWNLOADED AT 1247
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We will elect to add up the expense columns:

Transform  Add Column

Conditio

Index Column *
tom Invoke C
Function

Format
Dupli =

General

View

M

ge Columns
155 Bxtract ©

Parse

From Text

Statistics Standard Scientific

Trigonometry ~

From Number

Information ~

ding ¥

Date  Time Dur:

From Date & Time

fx || = Table.reordercol{

~ | [ pate ~|
11/05/2015 00:00:0(
11/05/2015 00:00:0¢
11/05/2015 00:00:0(
12/05/2015 00:00:0¢
12/05/2015 00:00:0(
13/05/2015 00:00:0¢
13/05/2015 00:00:0(
13/05/2015 00:00:0¢
13/05/2015 00:00:0¢
13/05/2015 00:00:0¢
13/05/2015 00:00:0¢
13/05/2015 00:00:0¢
14/05/2015 00:00:0¢
14/05/2015 00:00:0¢
20/05/2015 00:00:0¢

nditional

Queries

23R [2]3 o] ~|a] v |=]w ||~ |E

Add Custom Column

New column name
Expense Total (custom)
Custom column formula

=[Petrol] + [Hotel] +
[Train] + [Taxi]|

[Food] + [sundries]

Learn about Power Query formulas

v/ No syntax errors have been detected.

+ [stationary] +

Available columns:

e
Petrol
Hotel
Food
Sundries
Stationary
Train

Taxi

<< Insert

X [¥]| Query Settings X
4 PROPERTIES

Name

Pivot Column

All Properties

(o] 4 APPLIED STEPS
Source
Changed Type
Pivoted Column

X Reordered Columns.

Cancel

= | Pivot Column - Query Editor X
I vore  Tensorm  Addcomn  View @
rJ j- 13 Conditional Column ", [l Merge Columns Trigonometry ~
27 index Column ~ S bract+ Rounding *
Custom Invoke Custom . Format dard Scientific Date  Time  Duration
Cotomm  Function - CE1 Duplicate Column i Pa 2 z z Information ~ F E
General From Text From Number From Date & Time
Jc || = Table.addcolum(s"reordered columns”, "Expense Total (custom), each [Petrol] + [Hotel] + [Food] + [sundries] + | Query Settings x

E2. [~]12petrol [~/ 12 Hotel [~|12Food [~]12 sundries [~|12 stationary  [~|12Train  [~]12 Tax [ 55 ExpenseTotal (custom) | -
g |[1 nul null 39 nul null aull nuil nuy | 4 PROPERTIES
g 2 null 210 nuil null null null nul nun | Neme

Piv

3 w0 null null nul null aull nul nuil ver Column

4 null null 1245 null null null null null All Properties

5 nul null null 1112 nuil aull nuil nu

4 APPLIED STEPS
6 null null 43.16 null nuil null nul nu
7 nul 130 null nul nuil aull nuil nuil Source
Changed Type
8 50 null nuil null null null nul null !
nul null 43.16 nul nuil aull nuil nuil Pivoted Column
Reordered Columns
10 null 130 nuil null nuil null nul null
X Added Custom

1 nul null nuil nul null aull 25 null

12 null null nuil null nuil s nul null

13 nul null 2205 nul null aull nul nuil

14 null null 2295 null nuil null nul null

15 nul null null nul 5 aull nul nuil

Anything added to a null is null, which is not what we want at all. We could replace the null values with zero, but zero is not strictly the same as null,
and besides, there is a better way — we like this way because it’s delightfully simple and doesn’t require any M code knowledge at all.

Firstly, select all the columns you want to add up by holding down the CTRL button as you make your choices:

&

= | Pivot Column - Query Editor

Trigonometry *

rformation ~

~ 12 Sundries

From Dace & Time
[Petral] +
~|12 stationary
nuil
il
nuil
il
112
nuil
nuil
il
nuil
il
nuil
il
nuil

nuil

B oo oom  rddcoumn v
D Condiional Col rfMergeColumns X O
=7 Index Colurn + 5§ Extract - > BE 9 Rounding *
Custom Iivoke Custom Formal. Stalistics Star dard Scientific
Column Function wplicste Column - parse ™ - - -
General From Text From Number
Je || = 1ahle.addcaluan(# keordered (alumns”, "1 xpense latal (custom)”, each
. -] #c Employee  [~]12 Petrol  [~|12 Hotel  [~]12 Food
g 1 /201500:00:00 Mary Wells nail null 39
S 2 /2015000000 Mary Wells il 210 nl
© 3 2015000000 ey sl 10 null null
4 /201500:0000| Mery Wells il null 1245
5 /201500:00:00 Mary Wells nail null null
0 /201500:00:00 Derek Stand il null 4216
7 /201500:00:00 | Derek Stand il 130 null
8 /201500:0000| Derek Stand 0 null nuil
9 /201500:00:00 Paul simmons il null
10 /201500:00-00 Paul Simmans il 130
11 /2015 00:00:00| Paul Simmons il null
12 /201500:00-00 Paul Simmans il null nuil
13 /2015 00:00:00| Derek stand il null 2295
14 /201500:00-00 Paul Simmans il null 2295
15 /2015 00:00:00 Mary Wells nail null null

contact@sumproduct.com | www.sumproduct.com |

il

Tirne  Durativy

~] 12 Train

null

[intel] + [tood] + [sundries] +

v y
~ T s
= = 4 PROPERTIES
nul! nuli Name
" : Pivol Colurmm
nu nul
nun nall Al Propeies
nul! null
a | 4 APPLIED STEPS
- p— Source
= o Changed Type
Pivoted Column
nul! null
| : Reordered Columns
= X Added Custom
nul! 25
nul! null
nun nall
nul! null
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Secondly, in the ‘Add Column’ tab, go to the ‘Standard’ dropdown in the ‘From Number’ section:

[x] Pivot Column - Query Editor o X
I vore  Tensorm  Addcoumn  View %)
=] L Conditonal Column [ Merge Colomns X O | EEE
= Index Colurmn = 455 Extract > BE nding =
Custom Invoke Custom U pomat Statisics Standard Scienific . Dste Time Duration
R Duplicate Column i Parse - " i Information e
General From Text Add From Date & Time
Mliply
- Table.Addcolumn(#"Reordered Columns”, "E )", each [Petrol] + [Hotel] + [Food] + [Sundries ary e
> f umn( u N ) [Petrol] + [Hotel] + [Food] + [sundries] + ]| Query settings v
= =] M Employee  [+]12 Petrol  [~] 12 Hotel 2 Sundries (-] 12 Stationary  [~]12 Train [~ |12 Tad - 4%
§ 1 /201500:00:00 Mary Wells null null null null null “ PROPERTIES
S 2 /2015000000 Mary wets nall null nul ! nll Name
3 /201500:00:00 Mary Wells o nll nul nl ol Fivot Column
4 /201500:00:00 Mary Wells nall nll nul ! il Al Properties
5 /201500:00:00 Mary Wells nll nun nun 1112 nul nll ol
4 APPLIED STEPS
6 /201500:00:00 Derek stand nall nul .16 null nul ! nll
7 /201500:00:00 Derek Stand null 130 null null nul ! nul Source
8 /201500:00:00 Derek stand 50 nul nul null nul ! il Changed Type
Pivoted Column
9 /201500:00:00 Paul Simmons nll null 4316 nll nul null nul
Reordered Columns
10 /2015 00:00:00 Paul Simmons nll 130 nul nall nul ! il
X Added Custom
11 /2015 00:00:00 Paul Simmons nll null nul nll nul ! 25
12 /2015 00:00:00 Paul Simmons nall nul null null nul 4 nll
13 /201500:00:00 Derek Stand nll null 2295 nll nul null nul
14 /2015 00:00:00 Paul Simmons null nul 2295 null null ! il
15 /2015 00:00:00 Mary Wells nll null nul nll 5 null nul
< >
ROWS PREVIEW DOWNLOADED AT 13:20

This will allow us to add all the selected columns, and it is much better than the custom column:

&- < | Pivot Column - Query Editor g X

Home  Transform  AddColumn  View @
il B Conditonat Colurmn 517 Merge olumns BE 2 igonomeny~
= . lasc] . Bl 100 .
=7 Index Column 15 Batract 578 Rounding
Custom Invoke Custom Format Statistics Standard Scentifc 1 Dste Time Durator
Custom nvoke CUSIOM 0 ot Column " 85 Parse » isics Sandard SINURC [ on = 0% TITe Dt
General From Text From Number From Date & Time
- Table.AddColumn(#"Added Custom”, "Sun”, each List.sun({[Stationary], [Petrol], [Hotel], [Food], [Sundries], [Train], v .

> f ( @ y1, [petrol], [votel], [Food], [ 1, Crrain] Query Settings

@ ~ 1.2 Hotel ~| 1.2 Food ~ 12 Sundries ~ | 1.2 stationary ~ 12 Train ~]12 Taxi ~ 155 ExpenseTotal (custom) |~ |12 Sum  ~
$ 1 nul 39 ol null nul null null 39 | 4 PROPERTIES

é 2 null 210 null null null null null null 210 Name
3 w0 nul ol ol ol nul ol nul a0 | [PivotColmn
4 null 1245 nul ol nul nall null 1245 Al Properties
5 ol null ol 1112 ol nul null nul 112

4 APPLIED STEPS
6l null 4216 nul ! nul nall null 416
7 130 ol ol ol nul null null 130 Source
8 50 null ol nul ! nul nall ! 50 Changed Type
9 null nul 1316 null null null null null 43.16 Pivoted Column
Reordered Columns
10t 130 ! nul ! nul nall null 130
Added Custom
1 null ol ol ol nul 25 nul 25
X Inserted Sum
2 null ! nul ! a5 nall ! s
3 null 2205 nul ol nul null nul 2205
14 null 2205 nul ! nul nall ! 2205
5 null ol nul 5 nul null null 3
< >

17 COLUMNS, 15 ROWS PREVIEW DOWNLOADED AT 1330

This is definitely a useful tool to know about — the new Sum column has dealt with the nulls and added everything up. The reason why it works, is
because the M code behind the step uses List.Sum instead of simply adding with ‘+"

If you compare the two formulae, the original (flawed) approach used the M code:

= Table.AddColumn (#"Reordered Columns", "Expense Total (custom)", each [Petrol] + [Hotel] + [Food] +
[Sundries] + [Stationary] + [Train] + [Taxi])

whereas the second Power Query generated column operates on a list basis:

= Table.AddColumn (#"Added Custom", "Sum", each List.Sum({[Stationary], [Petrol], [Hotel], [Food],
[Sundries], [Train], [Taxil]}), type number)

More next month!
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Power Bl Desktop Update for November

There were some major updates last month. There’s a new, modern Ribbon that aligns Power Bl Desktop with Office and adds more functionality.
There’s a new visualisation too: the decomposition tree, which is one of the most requested ideas out there on the interweb thingy. Al functions have
also been integrated into Power Query allows you to enhance your data transformations, plus the usual odds and sods.

Here’s the complete list of November updates:

Key change

¢ Modern Ribbon (Preview)

Reporting

e Decomposition tree visual (Preview)

Analytics

¢ Conditionally format button formatting

Visualizations

¢ ArcGIS Maps for Power Bl update
¢ New xViz visuals:

o Advanced Gauge

o Hierarchical Filter
e ZoomCharts Drill-Down Waterfall Visual
¢ Financial Reporting Matrix by Profitbase
¢ Distribution

* Tree

Data connectivity

e LinkedIn Sales Navigator connector

e Edit SAP variables experience now Generally Available

* Vena connector

® Sitelmprove connector

¢ Product Insights connector

¢ Web By Example connector — support for extracting links

Data Preparation

¢ Al functions in Power Query (Preview)

Template apps

e LinkedIn Sales Navigator for Sales Operations.

Let’s take a look at each in turn.

Modern Ribbon (Preview)

The Ribbon in Power Bl Desktop has been updated for a “more modern experience”. Now, when you turn on the “Updated Ribbon” preview feature,
you will see a Ribbon that looks more like the Ribbon in Office products. In the updated Ribbon, you have access to all the existing functionalities but
there will be more features too.

Microsoft stated that their aims were to:

* Make the report design experience easier
e Align the Ribbon with Office
e Provide a visual refresh and modernise the aesthetic of Power Bl’s User Interface.

This means that another Ribbon tab has been added and the buttons in each tab have been reorganised into conceptual groupings. If this Ribbon
looks familiar to you, it is because you will now be using the same Ribbon that you see when using Office 365:

BB 20195010 Video Demao - Power Bl Desidop

File Home et Maodeling View

@G0

ielp

= 0D

SOUTTES »

wer BI 501

data= datssets Sorve
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This new Ribbon has several benefits compared to the previous one:

¢ Improved look, feel and organisation
e A Themes gallery, where you can more easily see which colours will be applied

5

Aa Aa Aa Aa Aa
Inlnald| lulnalsl nlualn!| nlantall] Inlualal] > @ Pace
view v
Themes Scale to fit
| C e Do D Y g

¢ Dynamic Ribbon content based on your view, so you no longer have so many disabled buttons in the Data and Modeling views

@ 20195010 Video Demo - Power Bl Desktop

File Home Help Table tools
Cut E?H B S . R 7 [?% ==
Opy
Paste RY Get Excel PowerBl SQL Enter Recent Transform Refresh Manage
b data~ datasets Server data sourcesw dataw~ relationships
Undo Clipboard Data Queries Relationships
[Dol r A
Date ' Maonth '_ Year ' MaonthN '
@ Sunday, January 1, 2012 | Jan 2012 1
[',ia Mondoy, Jonwvary 2, 2012 | Jan 2012 1
=]

e Asingle line Ribbon when the Ribbon is collapsed, which allows you to save space while working (see below)

¢ The Ribbon won’t occasionally freeze, for those who had this issue before.

Adding buttons, shapes, and textboxes to your report have been moved to a new Insert tab:

File Home Insert Modeling View Help
n =
iz W AU IR0
New  More New Text Ask your Buttons Shapes Irrlage
visual visuals v pagev box  data = v
Visuals Pages Elements

The updated Ribbon displays themes in a gallery so you can more easily see what colours will be applied to your report:

File Home Insert Madeling View Help
|I||I
This report
| Aa
((lnlnalul
! Power Bl
Aa Aa Aa
liluslil E Inlusls lnluall
Aa Aa Aa Aa
il Ialss il lilushal
Aa Aa Aa Aa
T | tlualal] | alualull
Aa Aa Aa Aa
e o (luluc il hilmial

[B Browse for themes...

Theme gallery

How to create a theme
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You can still see the name of a theme by hovering over a thumbnail, viz.

ﬁ: ul

Eloom

A
TRRLLL|

Aa
Ials: al

More tabs, also known as contextual tabs, will show up in the Ribbon
according to what you have selected. For example, in the previous
Ribbon, if you selected a visual, the contextual tabs Format and ‘Data /
Drill” appear. In the new Ribbon, you may have noticed that the Modeling
tab has fewer buttons. Now, if you want to modify the structure,

properties or apply formatting to tables, columns and measures, these
options will appear as contextual tabs when you select a field in the fields
list. The tools available to modify your data are now grouped according
to the type of field you have selected. This should help reduce clutter
and unnecessary options as you are modifying your data.

File Home Insert Modeling View Help Table tools
£t =5 B & B
@ Name  Sales El e
Mark as date Manage New Quick New MNew
table ~ relationships | measure measure column table
Structure Calendars Relationships Calculations
File Home  Insert  Modeling  View  Help e
¢ mame | Country $% fomat 5 summa ston | Dontsummanzs  ~
33 Dwlatpe | Ten B ostacateg Uneategorized w
'
File Home nsert Modeling View Help Measure tools
@ Masmse kan Set Measurne S% Famnat E Data categary  Uncategarized - s
Hew  Quick

ﬁ Home table b

setunn Fermatting

Some descriptions have changed. Previously, you could browse custom
visuals in the button ‘From Marketplace’. Since custom visuals are hosted
in AppSource, you can now find them by pressing the ‘More visuals’
dropdown and selecting ‘From AppSource’ instead.

File Home Insert Modeling View

Help

:D_' Mew visual [Pﬁ More visuals v

& H-n OVERVIEW

{7 New page v

$1.100

[E] Text box

$1.560

Feasure measure

Real estate has become more of a priority too. If you press the chevron
in the bottom right hand corner of the Ribbon, it will collapse to help you
save space while working.

£ Ask your data

$330

['_'n' Buttons v l?j Shapes ~ E" mage

$480 $1.¢

It’s no secret that some of the terms that appear in the Ribbon are ambiguous. With this borne in mind, Microsoft has updated some of the names
for buttons to be more friendly. The ToolTips have also been updated to give a more detailed explanation as to what each feature does.

Some of the more prominent changes include:

¢ | must confess, this is not one of my favourite changes, but ‘Edit Queries’ now appears as ‘Transform data’

e L

SQL Enter Recent
Server data sourceswv

4 L

Transform Refresh
data~

i [A] |

Text b
box wis

MNew
visual

Use the Power Query editor to connect, prepare, and transform
data,

e Adding a custom visual ‘From Marketplace’ is now ‘From AppSource’ (I can’t help thinking this is Apple Sauce...)

ﬁ:

Quick
measure measure

i

More
visuals

New

: dl",_ From AppSource

= From my files
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¢ ‘From AppSource’ is now be found under the ‘More visuals’ dropdown

(> iAldz| B %

Refresh New Text | More New  Quick 3
visual box |visuals~ Measure measure

Add Power Bl visuals from AppSource or from your files.

* Since ‘See Data’ shows the data in a selected visual in a tabular format, it has been renamed as ‘Visual table’

EJ Ef,.é\ Apply drilling t
Visual |Data point ;
table table Entire page

See the data in a visual as a table,

e ‘See Records’ has been renamed ‘Data point table’, which shows the underlying data that has been used to calculate a data point in a tabular
format.

| - | | l Swit
x)\ Fa Apply drilling to

Expand ne
Visual [Data point xpand n
table table

Entire page v

See a table of the data used to calculate a single data point.

The file menu also has a more modern look. If you work with several reports, in the Open section of the modern file menu, you’ll be able to see and
pin more reports than you were able to previously.

Get Data

Mase Camimsa
| Excel
Pt Bl datagets
y Poravis B claaflcwni
S0 Server catabare
s Apune Anakid Senioes database
[ Tt/ C5¥

Web

B

Cibats feed
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Therefore, to summarise:

Formerly known as

New name

Edit Queries

Transform data

From Marketplace

From AppSource

Switch Theme Turned into a Theme gallery
New Group New data group

Edit Groups Edit data groups

Prince Love symbol

Other points:

New visual

New page Home -> Insert group Insert -> Pages group

New visual Home -> Insert group Insert -> Visuals group

Buttons Home -> Insert group Insert -> Elements group

Text box

Image

Shapes

From AppSource Home -> Custom visuals group Home -> Insert group -> more visuals
From File

Switch Theme Home -> Themes group View -> Themes group

Manage Relationships

Home -> Relationships group

Modeling -> Relationships group

Data Formatting group
Data Properties group

Modeling

Once you select a table, column, or
measure in the Fields List, contextual
tabs (Table tools, Column tools, Meas-
ure tools) will appear in the Ribbon

New data group
Edit data groups

Modeling -> Groups group

Select a column in the fields list

Column tools -> Groups group
-> Data groups

Microsoft states that this will be the first of many updates that are coming to the Ribbon. The new Ribbon control allows them to, in future updates:

e Use more flexible and intuitive controls for features
e Add the black and dark grey Office themes to Power Bl Desktop

e Improve accessibility to be on par with Office’s Ribbon.

It should be noted that the Quick Access Toolbar will be unavailable in
the updated Ribbon, although in a future update ‘Save’ will be added to
the title bar.

As for the timeline, it is expected that in the first quarter of 2020,
the updated Ribbon will transition from being a Preview feature to
becoming the default Ribbon in Power Bl Desktop. If the updated Ribbon

experience is severely impacting your workflow, you will still be able
to turn off the updated Ribbon in your Preview features in the report
options dialog. However, when the updated Ribbon is the new default,
the previous Ribbon will be deprecated. You should note that if you do
turn off the updated Ribbon, you will not get access to all the newest
features in Power BI.
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Decomposition tree visual (Preview)
One of the most requested features for Power Bl is coming to Preview: whole. The visual lets you decompos, or break down, a group to see its

a decomposition tree visual. This may be used to perform root-cause individual categories and how they can be ranked according to a selected
analysis by viewing how individual categories in a group contribute tothe  measure, such as by sales amount.

Class - Sale Size X Manufacturer e Country

United States

Fabrikam, Inc.
$1,352.430

Medium tum Corporation =
41998200 Canada
187
/' Regular Small Contoso, Ltd
I £2 858,289 §814,837 A 4
N B l
Sales Amount Drehuoe Large
$4.4570 §1.085, 79§ $45.150
==

Economy =
£312.947 Germany
$57.98

Once you turn on the visual through the Preview tab of the Options dialog, you'll see the new visual option in the Visualization pane.

o e E
Decomposition Tree

r

Once you add the visual to your page, you'll see two buckets in the field well. The first, Analyze, is where you’ll put the numeric field you want to

break down, in this case, Sales Amount. The second bucket, ‘Explain by’, is where you’ll put all the possible fields you’d want to break your numeric
field down by.

T R

Analyze

Sales Amount X
Explain by

Sale Size X
Manufacturer WX
Color X
Class X
Country ¥

One of the interesting differences in the decomposition tree, compared to other visuals, is that you get to pick dynamically which of the fields in the
explain by field well you want to look at and in what order. This means that the initial view you'll have is just the numeric value with a small ‘+’ next to it.

|
Sales Amount

4 45T N3
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Clicking on this plus (‘+) will allow you to either pick a specific field from the provided options to break down by or let the visual decide which field
to use, depending on if you're looking for the highest or lowest value.

.|
Sales Amount Q High value

o Q Low value
Country
Color
Class
Manufacturer

Sale Size

As you expand on different fields, you'll see a path forming in your tree. If the tree expands beyond the dimensions of the visual, you can pan and
zoom with your mouse to get a better view.

Country Class

As you go further down the tree, you can look at the headers and the darkened lines to get a reminder of what part of the tree you're exploring.

Country

=

Sales Amount

If you pick either high or low values to expand on, you'll also see a lightbulb next to the header to remind you that Power Bl is picking the field for you
dynamically and it’ll update and change as your data refreshes. The connecting line is also dotted, which is another visual cue.

Sale Size

2 !ﬂq-di-um

Smal
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Like our other built-in visuals, you get all the good features you’d expect, such as support for:
e Cross-highlighting
e Picking up theme colours
* Formatting options

=%
F @

£ Search

o Anabysis

~ Dada bars

Positivee bar

o~

Megainve bar
D -
e Bookmarking.

When you save your report, the visual will remember what configuration  If there are specific levels you don’t want your users to change, you can
it was in and reopen to that format, but your consumers will be able to  lock them using the lock icon near the header (you won’t have this option
explore and configure the visual as much as they want to find new insights. ~ for Al driven levels).

Class

Conditionally format button formatting
November’s conditional formatting updates for formatting are all button related. You can now dynamically set formatting for the following properties:

¢ Button text font color

* Button text

® Icon line color

e OQutline color

e Fill color

e Button ToolTip (under the Action card).

As a reminder, you can tell a property can be conditionally formattable by looking for the three dots on hover.

~ Action On —@

Type
Bookmark

Bookmark

Decomp Tree fully e..
Tooltip D

Revert to default

Once a property has been dynamically set, it will be replaced with an f, button.

Tooltip
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ArcGIS Maps for Power Bl update

The ArcGIS Maps for Power Bl visual has several updates this time. The a free user and 10,000 as an ArcGIS subscriber. Lastly, if you’re an ArcGIS
visual now has support for connecting to ArcGIS Enterprise servers using  subscriber you now get full Esri Technical Support for ArcGIS Maps for
built-in authentication. You can also now geocode up to 3,500 points as  Power BI.

New xViz visuals

This month, there are two new visuals in the xViz, an all in one visual pro features. If you decide to license the pro features, you get access to
suite. There are currently nine visuals in the package, all with free and  the advanced capabilities for all the visuals for one price.

ADVANCED GAUGE

The Advanced Gauge visual allows you to easily compare an actual value, such as your key business indicators, against a target value. There are
several customisation and configuration options available for this visual. Your gauge can either be a full or semi-circle, with the added ability of
showing two different metrics in the same gauge.

Some other configurations include:

¢ Conditional formatting options for the gauge fill colour
¢ Set afilland / or needle indicator for the current value
e Control the colours for the target indicator

e Setaminimum / maximum value

e Axis and number formatting, including tick control.

State Battle Cost and State Bottle Retad

&

5 316525

Sale (Dollars)

HIERARCHICAL FILTER

The Hierarchical Filter visual is a slicer visual that supports hierarchies, advanced formatting, search and even displacing a metric of choice. Each node
of the slicer allows you to expand and collapse it for optimal navigation and allows you to single and multi-select categories to filter by.

Some of the advanced formatting options for this visual include:
e Conditional formatting support for both the categories of the slice and the optional metric
e Search support with two different search types

e Setting the default expansion level
¢ Full text and background formatting, including unique formatting for hover and selected value

e Advanced number formatting.

Bottles Sold (ml) by City, County, Store

",

— O AcKLey \

~ O Hardin 275
— O KUM & GO #513 / ACKLEY 2,750.00°

O Monday, July 22,2013 75000

O Monday, July 29, 2013 500.00

O Monday, January 13, 2014 750.00

O Monday, August 10, 2015 750.00

— O Webster 3,250.00

— O Ackley Super Foods 3,250.00

O Monday, July 2, 2012 750.00

O Monday. May 13, 2013 750.00

O Monday, January 6, 2014 1,750.00

—~ O apair 7,000.00
— O Adair 7.000.00

— O Casey's General Store #2521 / Adair 2,125.00

O Monday, November 4, 2013 1,750.00

O Monday, August 25, 2014 375.00

— 0O kum & Go #76 / ADAIR 4,875.00

O Wednesdav. Februarv 8. 2012 750.00
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ZoomCharts Drill-Down Waterfall Visual

The ZoomCharts Drill Down Waterfall visual is a new addition to the family of ZoomCharts custom visuals and is equipped with features such as
interactive drill down, smooth animations and other customisation options. The visuals are designed to work on both desktop and mobile devices
providing an intuitive user experience.

The ZoomCharts Drill Down Waterfall visual’s key features include:

¢ Subtotal display and calculation: add and display subtotals straight from the dataset or calculate them automatically
¢ Column sequence: set the display order for columns (change values)
¢ Display of the total: turn on or off the total column; have it calculated dynamically or make it data driven

¢ Advanced formatting options: customise increases, decreases and totals separately (colours, outlines, column widths, connectors, value
labels and more)

¢ Touch-driven slicer: filter the report page by using the visual itself (no need for external slicers)

¢ Touch-driven drill down: touch or click any column to drill down into it; long-press it to select the column.

Some common use cases for the Drill Down Waterfall include total profit and loss decomposition in accounting and finance, monitoring stock
movement in inventory management, understanding campaign contributions to lead volume in sales and marketing, and viewing changes in staff
numbers in human resources.

“Fv2019 Q3 - T

Provisions

f 140K | Hegatve 2018 208k
: 42 91K

b 39.24K

i aox

Financial Reporting Matrix by Profitbase

The Financial Reporting Matrix by Profitbase visual is geared towards easily building financial reports. The visual is a matrix with many of the
formatting options you’d expect in a financial report.

Some of the features of this visual include:

¢ Sub and grand total controls
¢ Line formatting
e Sticky column and row headers

e Conditional formatting.

Totsl Oppring bajom L BILTRY AT i ERELE L ol A s

“ >

4 xsem

a0 4 “ 4 4

A

4

y "
Tatsl Ciparstisg Costs 7797 142,310 218,507 RETE = 1k H 1,258,458 278,724 220
EaToA 84,502 w78,082 -iTasse BLE 2588088 2,880,280 341418 EIE
Het Fnancisl iverea e [ eﬂ 1L3% 1428 1404 & 4T
LEL 8502 EELE 178,504 BLLE LS 25851087 LETR B 341,604 EAE
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Distribution

The Distribution visual by Inservit allows you to see an indicator for each categories of the field you putinto the visual, much like the legend of a visual.
You can use these indicators as a way to filter the report.
The indicators have a lot of formatting options, including:

e Ability to show or hide the category and data labels

e Change the indicator border and share

e Swap the orientation between horizontal and vertical
e Conditional formatting for the indicators and border.

ol Custom Visual: Distribution | Indicators Inservit

Rev. by Month

(XX L X ] L]

Tree

The Tree visual by CK Corporation allows you to visual your hierarchical data in an easy to use tree structure. All you need to do is give the visual a
parent ID and child ID, and it will automatically figure out the tree structure. If there are multiple levels to the tree, you can expand nodes by hovering
over them and clicking the plus icon.

You can also use various formatting features, such as:
¢ Switching between horizontal and vertical orientation
¢ Set the default expansion level
e Customise the labels
e Change the node and line styles

¢ Set conditional formatting for the nodes.

Expanded Tree with Corner Link " Paseritid I

() 52.00%

B g ) 6.90% :
~ I s 50% :

| O T ) >130% ;
()Root ;
() 9.10% :

)-10.70% : :

() 0.00% z

LinkedIn Sales Navigator connector

LinkedIn Sales Navigator lets you access the power of Linkedin’s need to have a LinkedIn Sales Navigator Enterprise plan, and be either
630-million-member network to help sales professionals find and build an Admin or Reporting User on the Sales Navigator Contract to connect
relationships with prospects and customers. If you're using this feature, to this data.

you can now pull your data into Power Bl using our new connector. You
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M

LinkedIn Sales Navigator

1 Return data |

hese contracts (0

End Date (optional)

Edit SAP variables experience now Generally Available

Back in August, Microsoft released a preview of the Edit SAP variables
experience, to allow report consumers to edit SAP variables in the
Power Bl service with their DirectQuery reports. November sees the

Edit variables

Display options

Date_Batween

oK Cancel

announcement that this experience is now Generally Available and also
supported in Shared workspaces.

Vena connector

Vena’s finance process management software provides budgeting,
forecasting, planning, financial close management and consolidations,
and more, by connecting people and enterprise data, resulting in

Sitelmprove connector

Sitelmprove offers a comprehensive cloud-based Digital Presence
Optimization (DPO) software.  The connector gives access to
Sitelmprove’s digital insights data to monitor your websites performance

Product Insights connector

automated planning / decision making. The Vena Power Bl connector
connects Vena data to Power Bl, enabling faster analysis.

for accessibility, SEO, analytics, quality assurance, and much more to
help you measure digital performance and work towards regulatory
compliance.

Product Insights is a new Dynamics 365 product which allows you to collect signals from your products and services, and gain valuable insight into
customer usage, in real-time. The connector accesses aggregated signal data (metrics) from Product Insights.

Web By Example connector — support for extracting links

There’s a significant enhancement to the Web By Example
connector in this update, allowing you to extract links (src / href
attributes) as part of the Web By Example experience.

For example, this illustration leverages this new capability in
order to extract information about Power Query Books (including
Author, Title and URL) from the Power Query resources page:
https://powerguery.microsoft.com/en-us/resources/
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Al functions in Power Query (Preview)

After introducing Al functions in the Power Bl Service earlier this year,
Microsoft is now releasing these features into the Desktop world as
well. You can now extract insights from your text and image data with
models for text analytics and vision, and access all your Azure Machine
Learning models directly in Power Bl Desktop. There are new buttons in
the Power Query editor once you have the ‘Al functions’ option enabled
in the Preview settings.

Text Analytics

4 Text Analytics [3]
Jx Detect language
Jx  Extract key phrases

Jx Score sentiment Text

Premium capacity used for Al Insights

Default (based on availability) -

Text analytics can help you detect the language of a text column or field,
score its sentiment or extract key phrases. You may also detect topics in
images with the image tagging function or run new data through your
own Azure ML models. The results of each function are added as a new
column to the query.

O X
]
| ]
) . "
al Score sentiment
Measure the positive or negative sentiment of words and
phrases. Sentiment is rated on a scale of zero to one, with
one being the most positive.
T = | comments -
Language I1SO code (optional)
ABC -
OK Cancel

For functions that return multiple values (currently this is true for Key Phrase Extraction and Image Tagging) the results are returned both as a comma

separated column and as new rows for each separate key phrase or tag.

Text analytics and vision models are Premium only features. In the setup
window you can choose which capacity to use while editing the report.
When you publish the report to a Premium workspace, we will use the

LinkedIn Sales Navigator for Sales Operations

capacity related to that workspace for any data refresh. Text analytics
and vision functions cannot be refreshed in non-Premium workspaces.

The LinkedIn Sales Navigator for Sales Operations template app allows sales operations personnel to see aggregated information regarding how
effectively a sales team uses Sales Navigator. It enables sales operations personnel to identify and analyse things such as:

e Who is using LinkedIn Sales Navigator
e How many LinkedIn profiles match search criteria

e The Social Selling Index across all users.
To use this template app, you must:

e Have a LinkedIn Sales Navigator Enterprise plan

e Be an Administrator or a Reporting User on the Sales Navigator Contract (note: a reporting license on the Sales Navigator contract does not

take up a seat on that contract)

* Bea Power Bl user.

The LinkedIn Sales Navigator for Sales Operations template app is available for download from AppSource.

More soon, we’re sure!
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The A to Z of Excel Functions: DMAX

Wanna take it to DMAX? This function returns the largest number in a field (column) of records in a list or database that matches conditions you
that specify.

The DMAX function employs the following syntax to operate:
DMAX(database, field, criteria)

The DMAX function has the following arguments:
¢ database: this is required and represents the range of cells that makes up the list or database. A database is a list of related data in which
rows of related information are records and columns of data are fields. The first row of the list contains labels for each column

¢ field: indicates which column is used in the function. Make sure you enter the column label enclosed between inverted commas (double
quotation marks), e.g. "Age" or "Yield", or a number (without quotation marks) that represents the position of the column within the list,
that s, 1 for the first column, 2 for the second column, and so on. Microsoft’s documentation states that this argument is required. We’re not
convinced. If field is omitted, DMAX identifies the maximum of all of the records in the table that match the criteria

e criteria: is the range of cells that contains the conditions you specify. You can use any range for the criteria argument, as long as it includes at
least one column label and at least one cell below the column label in which you specify a condition for the column.

It should be further noted that:

e you can use any range for the criteria argument, as long as it includes at least one column label and at least one cell below the column label
for specifying the condition, e.g. if the range G1:G2 contains the column label Income in G1 and the amount 10,000 in G2, you could define
the range as MatchIincome and use that name as the criteria argument in the database functions

¢ although the criteria range can be located anywhere on the worksheet, do not place the criteria range below the list. If you add more
information to the list, the new information is added to the first row below the list. If the row below the list is not blank, Excel cannot add the
new information

¢ make sure that the criteria range does not overlap the list

¢ to perform an operation on an entire column in a database, enter a blank line below the column labels in the criteria range.

Please see our example below:

A B C D E
1
2 |Apple =3 <=
3 |Cherry
4
5
6 |Apple 6 20 14 105
7 |Apple a 12 10 96
& |Cherry 4.2 14 9 105
9 |Apple a7 15 10 75
10 |Pear 3 8 8 16.8
11 Apple 2.7 9 6 45
12
13

The maximum profit of any
apple tree with a height greater
than three but less than or
14 |=DMAX(A5:E11, "Profit",A1:C2) equal to four metres 96

Similar to above, this also

includes the profit of any cherry
15 |=DMAX{A5:E11, "Profit",A1:C3) tree 105
16
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The A to Z of Excel Functions: DMIN

The DMIN function

They say opposites attract. Last time out, we looked at DMAX, this time our attention turns to DMIN. This function returns the smallest number in
a field (column) of records in a list or database that matches conditions that you specify.

The DMIN function employs the following syntax to operate:
DMIN(database, field, criteria)
The DMIN function has the following arguments:
¢ database: this is required and represents the range of cells that makes up the list or database. A database is a list of related data in which

rows of related information are records and columns of data are fields. The first row of the list contains labels for each column

¢ field: indicates which column is used in the function. Make sure you enter the column label enclosed between inverted commas (double
quotation marks), e.g. "Age" or "Yield", or a number (without quotation marks) that represents the position of the column within the list,
that s, 1 for the first column, 2 for the second column, and so on. Microsoft’s documentation states that this argument is required. We’re not
convinced. If field is omitted, DMIN identifies the minimum of all of the records in the table that match the criteria

e criteria: is the range of cells that contains the conditions you specify. You can use any range for the criteria argument, as long as it includes at
least one column label and at least one cell below the column label in which you specify a condition for the column.

It should be further noted that:

e you can use any range for the criteria argument, as long as it includes at least one column label and at least one cell below the column label
for specifying the condition, e.g. if the range G1:G2 contains the column label Income in G1 and the amount 10,000 in G2, you could define
the range as MatchIincome and use that name as the criteria argument in the database functions

¢ although the criteria range can be located anywhere on the worksheet, do not place the criteria range below the list. If you add more

information to the list, the new information is added to the first row below the list. If the row below the list is not blank, Excel cannot add the
new information

¢ make sure that the criteria range does not overlap the list

¢ to perform an operation on an entire column in a database, enter a blank line below the column labels in the criteria range.

Please see the example below:

A B C D E
1
2 |Apple =3 <=
3 |Pear
4
5
& |Apple & 20 14 105
7 |Apple 4 12 10 96
& |Cherry 4.2 14 9 105
9 |Apple 4.7 15 10 75
10 |Pear 3 3 8 16.8
11 |Apple 2.7 9 6 45
12
13

The minimum profit of any
apple tree with a height greater
than three but less than or

14 |=DMIN(A5:E11, "Profit",A1:C2) equal to four metres 96

Similar to above, this also

includes the profit of any pear
15 |=DMIN(A5:E11, "Profit",A1:C3) tree 16.8

as

contact@sumproduct.com | www.sumproduct.com | +61 3 9020 2071




Criteria Examples

Typing an equal sign in a cell indicates you want to enter a formula. To display text that includes an equal sign, surround the text and the equal sign
with double quotes, like so:

"=Liam"

You also do that if you're entering an expression (a combination of formulas, operators, and text) and you want to display the equal sign instead of
have Excel use it in a calculation. For example:

="=entry"

Where entry is the text or value you want to find. For example:

="=Liam" =Liam
:ff>:1 " }:1

¢ When filtering text data, Excel does not distinguish between uppercase and lowercase characters. However, you can use a formula to perform a
case-sensitive search (see below).

The following sections provide examples of complex criteria.

Multiple criteria in one column
Boolean logic: (Salesperson = "Tim" OR Salesperson = "Kathryn")
To find rows that meet multiple criteria for one column, type the criteria directly below each other in separate rows of the criteria range.

e.g. In the following data range (A5:C9), the criteria range (B1:B3) displays the rows that contain either "Tim" or "Kathryn" in the Salesperson column
(B5:B9).

A B C

1

2 =Tim

3 Kathryn

4

3

& |Consulting Kathryn 5 1,744
7 |Training Tim 5 9,183
& |Auditing Kathryn 5 2,599
9 |auditing Cecile 5 1,117
n

Multiple criteria in multiple columns where all criteria must be true
Boolean logic: (Service = "Auditing" AND Sales > 1500)
To find rows that meet multiple criteria in multiple columns, type all of the criteria in the same row of the criteria range.

In the following data range (A5:C9), the criteria range (A1:C2) displays all rows that contain "Auditing" in the Service column and a value greater than
$1,500 in the Sales column (C5:C9).

A B C

1

2 |=Auditing >1500

3

4

3

& |Consulting Kathryn 5 1,744
7 |Training Tim 5 9,183
& |Auditing Kathryn 5 2,599
9 |auditing Cecile 5 1,117
in
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Multiple criteria in multiple columns where any criteria can be true
Boolean logic: (Service = "Auditing" OR Salesperson = "Kathryn")
To find rows that meet multiple criteria in multiple columns, where any criteria can be true, type the criteria in different rows of the criteria range.

In the following data range (A5:C9), the criteria range (A1:B3) displays all rows that contain "Auditing" in the Service column (C5:C9) or "Kathryn" in
the Salesperson column (B5:B9).

A B C
1
2 |=Auditing
3 Kathryn
4
]
& |Consulting Kathryn 5 1,744
7 |Training Tim 5 9,123
8 |Auditing Kathryn 5 2,599
& |auditing Cecile 5 1,117
10

Multiple sets of criteria where each set includes criteria for multiple columns
Boolean logic: ( (Salesperson = "Kathryn" AND Sales >2000) OR (Salesperson = "Tim" AND Sales > 1500) )
To find rows that meet multiple sets of criteria, where each set includes criteria for multiple columns, type each set of criteria in separate rows.

In the following data range (A5:C9), the criteria range (B1:C3) displays the rows that contain both "Kathryn" in the Salesperson column and a value
greater than $2,000 in the Sales column, or displays the rows that contain "Tim" in the Salesperson column (B5:B9) and a value greater than $1,500
in the Sales column (C5:C9).

A B C

1

2 =Kathryn =2000

3 Tim =1500

4

]

& |Consulting Kathryn 5 1,744
7 |Training Tim S 9,183
& |Auditing Kathryn 5 2,599
g |auditing Cecile S 1,117
10

Multiple sets of criteria where each set includes criteria for one column
Boolean logic: ( (Sales > 2000 AND Sales <= 3000 ) OR (Sales < 1500) )

To find rows that meet multiple sets of criteria, where each set includes criteria for one column, include multiple columns with the same column
heading.

In the following data range (A5:C9), the criteria range (C1:D3) displays rows that contain values between 2,000 and 3,000 and values less than 1,500
in the Sales column (C5:C9).

A B C ]
1
2 #2000 <=3000
3 <1500
4
5
& |Consulting Kathryn 5 1,744
7 |Training Tim S 9,183
8 |Auditing Kathryn 5 2,599
g |auditing Cecile 5 1,117
in
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Criteria to find text values that share some characters but not others

To find text values that share some characters but not others, do one or more of the following:

type one or more characters without an equal sign (=) to find rows with a text value in a column that begin with those characters. For
example, if you type the text Lia as a criterion, Excel finds "Liam", "Liar" and "Lianne"

use a wildcard character.

The following wildcard characters can be used as comparison criteria:

? ([question mark) Any single character
For example, sm?th finds "smith"
and "smyth"

* (asterisk) Any number of characters

For example, *east finds
"Northeast" and "Southeast”

~(tilde) followed by ?, *or~ A question mark, asterisk, or tilde
For example, fy91~7? finds "fy91?"

In the following data range (A5:C9), the criteria range (A1:B3) displays rows with "Co" as the first characters in the Service column or rows with the

second character equal to

in the Salesperson column (B5:B9).

A B C
1
2 |Co
3 =?j*
4
3
& |Consulting Kathryn 5 1,744
7 |Training Tim 5 9,183
8 |Auditing Kathryn 5 2,599
g |auditing Cecile 5 1,117
0

Criteria created as the result of a formula

You can use a calculated value that is the result of a formula as your criterion. Remember the following important points:

the formula must evaluate to TRUE or FALSE
because you are using a formula, enter the formula as you normally would, and do not type the expression in the following way:
="=entry "

do not use a column label for criteria labels; either keep the criteria labels blank or use a label that is not a column label in the range (in the
examples below, Calculated Average and Exact Match)

if you use a column label in the formula instead of a relative cell reference or a range name, Excel displays an error value such as #NAME? or
H#VALUE! in the cell that contains the criterion. You can ignore this error because it does not affect how the range is filtered

the formula that you use for criteria must use a relative reference to refer to the corresponding cell in the first row (in the examples below, C6
and A6)

all other references in the formula must be absolute references.

The following subsections provide specific examples of criteria created as the result of a formula.

Filtering for values greater than the average of all values in the data range

In the following data range (A5:C9), the criteria range (D1:D2) displays rows that have a value in the Sales column greater than the average of all
the values (€6:C9). In the formula, "C6" refers to the filtered column (C) of the first row of the data range (6).
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1

2 =C6>AVERAGE(SCS6:5CS9)
3

4

5

& |Consulting Kathryn S 1,744

7 |Training Tim 5 9,183

& |Auditing Kathryn S 2,599

9 |auditing Cecile 5 1,117

10

Filtering for text by using a case-sensitive search

In the data range (A5:C9), the criteria range (D1:D2) displays rows that contain "Auditing" in the Service column by using the EXACT function to
perform a case-sensitive search (A5:A9). In the formula, "A6" refers to the filtered column (A) of the first row of the data range (6).

A B C D

1

2 =EXACT[AS, "Auditing")
3

4

3

& |Consulting Kathryn 5 1,744

7 |Training Tim 5 9,183

& |Auditing Kathryn S 2,599

9 |auditing Cecile 5 1,117

10

More Excel Functions next month...

Upcoming SumProd

Course

Melbourne Power Pivot, Power Query and Power BI 9-11 Dec 2019

SLE Power Pivot, Power Query and Power BI 9-11 Dec 2019

SLE Excel Tips and Tricks 16 Dec 2019

SLE Financial Modelling 17 - 18 Dec 2019

Melbourne Excel Tips and Tricks 13 Jan 2020

Melbourne Financial Modelling 14 - 15 Jan 2020

SLE Power Pivot, Power Query and Power BI 15 - 17 Jan 2020

SLE Excel Tips and Tricks 27 Jan 2020
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Sydney Financial Modelling

Sydney Power Pivot, Power Query and Power BI

Melbourne

Sydney Excel Tips and Tricks

Sydney Financial Modelling

Key Strokes

Power Pivot, Power Query and Power BI

28 - 29 Jan 2020

17 - 19 Feb 2020

2 -4 Mar 2020

2 Mar 2020

ERE A\ Eglepli]

Each newsletter, we'd like to introduce you to useful keystrokes you may or may not be aware of. This month, we thought we would

SHIFT CONTROL of the function keys:

Keystroke

CTRL + SHIFT + F1

‘ What it does

Insert new sheet

CTRL + SHIFT + F2

Save

CTRL + SHIFT + F4

Close application

CTRL + SHIFT + F10

Show On-Object User Interface (OOUI)

CTRL + SHIFT + F11

Show Script Editor

There are over 540 keyboard shortcuts in Excel. For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the

www.sumproduct.com homepage.

Our Services

We have undertaken a vast array of
assignments over the years, including:

- Business planning

- Building three-way integrated
financial statement projections

- Independent expert reviews

- Key driver analysis

- Model reviews / audits for internal
and external purposes

- M&A work

- Model scoping

- Power BIl, Power Query & Power Pivot

- Project finance

- Real options analysis

- Refinancing / restructuring

- Strategic modelling

- Valuations

- Working capital management

If you require modelling assistance of any

kind, please do not hesitate to contact us
at contact@sumproduct.com.

Link to Others

These newsletters are not intended to be

closely guarded secrets. Please feel free

to forward this newsletter to anyone you

think might be interested in converting to
“the SumProduct way”.

If you have received a forwarded
newsletter and would like to receive
future editions automatically, please

subscribe by completing our newsletter
registration process found at the foot of
any www.sumproduct.com web page.

Any Questions?

If you have any tips, comments or queries

for future newsletters, we’d be delighted
to hear from you. Please drop us a line at
newsletter@sumproduct.com.

Training

SumProduct offers a wide range of
training courses, aimed at finance
professionals and budding Excel experts.
Courses include Excel Tricks & Tips,
Financial Modelling 101, Introduction to
Forecasting and M&A Modelling.

Check out our
more popular
courses in
our training
brochure:

Drop us a line at training@sumproduct.com
for a copy of the brochure or download

it directly from
http://www.sumproduct.com/training.
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